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1. Quick start guide  
 
1. Connect the logger or ChartReader. 
 
In order for the software to communicate with a logger or ChartReader you must connect the 
appropriate Communication Interface  to the serial port of your computer. Then place the logger 
into the Interface or connect the ChartReader to the Interface. 

 
For more help on how to connect the logger see How to connect the logger 
 
For more help on how to connect the ChartReader see How to connect the ChartReader 
 

 To make Escort Console work faster and more efficiently select the product(s) with 

which you are currently working and appropriate communication port. To do this: 

• choose Options command from Edit menu; 

• choose Products tab from Options dialog; 
• select product(s) and also you can set their priorities; 

• choose Communications tab from Options dialog; 

• select communication port(s) and also you can set their priorities; 

• click Apply button to set selected by you options and than click OK button to 
§ close the Options dialog. 

 
 
2. Program the logger or ChartReader. 

To program the logger or the ChartReader, click on the  toolbar button or select Program 

and Configure  from the Action menu. Escort Console will open Program and Configure  
Wizard, which allows you to input your requirements. 

 
For more help on how to program the logger see Programming the logger Overview. 
For more help on how to program the ChartReader see How to program the ChartReader. 
 
3. Download data from the logger or ChartReader. 

To extract data from the logger or the ChartReader, click on the  toolbar button or select 
Download Information from the Action menu. Escort Console  will open Download Readings 

Wizard, which allows you to retrieve and view the recorded samples from the logger or the 
ChartReader. 
 
For more help see Display list of readings. 
 
4. Viewing the data. 
After data has been successfully downloaded you can change its appearance by using View 
Manager’s tools Views, Links or Analysis.  
 

5. Save the data into a file. 
If you would like to save downloaded data please see how to save data into a file. 
For more help see supported file formats. 
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2. File menu commands  
 
The File menu offers the following commands: 
 

2.1 Open command (File menu) 
 

Use this command to open an existing document that contains logger data in a new window.   
You can open multiple documents at once.  Use the Window menu to switch among the multiple 
open documents.  See File open dialog. 
 
 
 

Shortcuts 

Toolbar:   
 
Keys: CTRL+O 
 

File Open dialog  
 
The following options allow you to specify which file to open: 

File Name  
Type or select the filename you want to open.  This box lists files with the extension you 
select in the List Files of Type box.  

List Files of Type 
Select the type of file you want to open: 
 
Note than this application works only with Logger Compact Files. 

Drives 
Select the drive in which Escort Console stores the file that you want to open.  

Directories 
Select the directory in which Escort Console stores the file that you want to open.  

Network... 
Choose this button to connect to a network location, assigning it a new drive letter.  
 

2.2 Close command (File menu) 
 
Use this command to close an active document that contains logger data. 
 

2.3 Save command (File menu) 
 
Use this command to save an active document that contains logger data. 
 
For help regarding supported file formats see file formats 

 
Shortcuts 

Toolbar:   

Keys: CTRL+S 
 

2.4 Save As command (File menu) 
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Use this command to save an active document that contains logger data to a specified file name.  
 
For help regarding supported file formats see file formats 
 

2.5 Print command (File menu) 
 
Use this command to print an active document.   This command presents a Print dialog box , 

where you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options. 

 
Shortcuts 

Toolbar:   

 

Keys: CTRL+P 
 

Print dialog box 
 

The following options allow you to specify how the document should be printed: 

Printer 
This is the active printer and printer connection.  Choose the Setup option to change the 

printer and printer connection. 

Setup 

Displays a Print Setup dialog box , so you can select a printer and printer connection. 

Print Range 

Specify the pages you want to print: 
All Prints the entire document. 

Selection Prints the currently selected text. 
Pages Prints the range of pages you specify in the From and To boxes. 

Copies 
Specify the number of copies you want to print for the above page range. 

Collate Copies 

Prints copies in page number order, instead of separated multiple copies of each page.  

Print Quality 

Select the quality of the printing.  Generally, lower quality printing takes less time to produce.  
 

Print Progress Dialog 
 

The Printing dialog box is shown during the time that Escort Console is sending output to the 
printer.  The page number indicates the progress of the printing.  

 
To abort printing, choose Cancel. 

 

2.6 Print Preview command (File menu) 
 
Use this command to display the active document as it would appear when printed.  When you 

choose this command, the main window will be replaced with a print preview window in which one 
or two pages will be displayed in their printed format.  The print preview toolbar offers you options 

to view either one or two pages at a time; move back and forth through the document; zoom in 
and out of pages; and initiate a print job. 

 

Print Preview toolbar 
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The print preview toolbar offers you the following options: 

Print 

Bring up the print dialog box, to start a print job. 

Next Page  

Preview the next page. 

Prev Page 

Preview the previous page.  

One Page / Two Pages 
Preview one or two pages at a time. 

Zoom In 
Take a closer look at the page. 

Zoom Out 
Take a larger look at the page. 

Close  
Return from print preview to the editing window. 

 

2.7 Print Setup command (File menu) 
 

Use this command to select a printer and a printer connection.  This command presents a Print 
Setup dialog box, where you specify the printer and its connection. 

 

Print Setup dialog box 
 
The following options allow you to select the destination printer and its connection. 

Printer 
Select the printer you want to use.  Choose the Default Printer; or choose the Specific Printer 

option and select one of the current installed printers shown in the box.  You install printers 
and configure ports using the Windows Control Panel.  

Orientation 
Choose Portrait or Landscape. 

Paper Size 
Select the size of paper that the document is to be printed on. 

Paper Source 

Some printers offer multiple trays for different paper sources.  Specify the tray here. 

Options 

Displays a dialog box where you can make additional choices about printing, specific to the 
type of printer you have selected.  

Network... 
Choose this button to connect to a network location, assigning it a new drive letter. 

 

2.8 User command (File menu) 
 

 
This command only available if  ’’User Admin Package for Title 21 CFR Part 11 

compliance’’ installed. 
 
Use this command to log on to Escort Console, or to log off from it, or to change your details 
(password). 
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To log on to Escort Console select Log On from User command. 
Shortcuts 

Toolbar:   
 
Keys: F9 
 

To log off from Escort Console select Log Off from User command.  
Shortcuts 

Toolbar:   

 
Keys: F10 

 
To change your details select Change Details from User command. 

 

2.9 Send command (File menu) 
 
Use this command to send the active document through electronic mail.  This command presents 
a mail window with the active document attached to it.  You may then fill out the To: field, Subject: 
field, etc., and add text to the body of the message if you wish.  When you are finished you may 

click the "Send" button to send the message. 
 

2.10 Properties command (File menu) 
 
Use this command to display the active document properties. 
 

2.11 Digitally Sign command (File menu) 
 

 
This command only available if ’’User Admin Package for Title 21 CFR Part 11 compliance’’ 

installed.  
 
Use this command to add your digital signature to the active document. 
 
Shortcuts 

Toolbar:   
 

In opened Digital Signatures dialog you can see signatures, if any were added at previous date.  
 

• to add digital signature click Add button. In opened Add a Digital Signature dialog 
select a meaning you wish to apply to your digital signature and click OK button. New 
digital signature will be added to the current document and will include your username, 
meaning and time stamp of the signature. 

 
• to print list of the active document digital signatures click Print button. 

 

2.12 1, 2, 3, 4 command (File menu) 
 
Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.  Choose the number that corresponds with the document you want to 
open. 
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2.13 Exit command (File menu) 
 
Use this command to end your Escort Console session.  You can also use the Close command 
on the application Control menu. Escort Console will prompt you to save documents if there are 
any unsaved changes. 

 
Shortcuts 

Mouse:  Double-click the application's Control menu button. 

Keys: ALT+F4 
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3. Edit menu commands  
 
The Edit menu offers the following commands: 
 

3.1 Copy command (Edit menu) 
 

Use this command to copy selected data onto the clipboard.  This command is unavailable if 
there is no data currently selected. 
 
Copying data to the clipboard replaces the contents previously stored there. 
 
Shortcuts 

Toolbar:   
 

Keys: CTRL+C 
 

3.2 Graph command (Edit menu) 
 
Use this command to customize appearance of the current graph. 
 

Data  
• This option gives you a choice to set your own title and comment to the current graph. 

Sensors 

• This option gives you a choice to set color and type of the line or marker for every sensor 
of the current graph; 

2D Graphs 

• change appearance of the graph, such as whether to include comment and title, or to 
display grid lines; 

• change border colors. 
Zoom 

• set maximum and minimum value for X and Y axis. 
Legend 

• change position of graph Legend; 
• list items, which can be included in Legend. 

Colors 
• set color for the graph, comment and Legend. 

 
 

 listed above options will change appearance of the current graph only. Should you 
wish to make same changes to all your graphs, please use Options command(Edit menu) 
 

3.3 Options command (Edit menu) 
 
Use this command to open options dialog, which allows you to customize your program settings. 
 
General 

• select temperature scale. This option gives you a choice to set temperature scale in 
Celsius, Fahrenheit, or Kelvin; 

• display or hide Status Bar, which is displayed at the bottom of the Escort Console 
window; 

• display or hide View Manager 
• display or hide Tip of the Day when Escort Console start. 
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File 

• choose how many recent file entries are displayed;  

• choose which default folder to store data logging files. By default it is ’’C: \My 
Documents\My Logger Data’’. 

Date  

• change date format. 
Time 

• change time format. 
Time Zone 

• change Time Zone settings. 
2D Graphs 

• change appearance of the graph, such as whether to include comment and title, or to 
display grid lines; 

• change border colors. 
Legend 

• change position of graph Legend; 

• list items, which can be included in Legend. 
Products 

• list and set priorities for loggers and ChartReaders. 
Communications 

• select the communications port. 
Languages 

• set language for display and printing. 
Colors 

• set color for graphs, readings and Legend. 
Advanced 

• choose advanced features applicable to your needs.  
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4. Action menu commands  
 
The Action menu offers the following commands: 
 

4.1 Program and Configure command (Action menu) 
 

Use this command to program  logger or  ChartReader. 
 
Shortcuts 

Toolbar:   
 
For more help about programming the logger see Programming the logger Overview. 
For more help about programming the ChartReader see How to program the ChartReader. 
 

4.2 Restart command (Action menu) 
 
Use this command to restart a logger. 
 
Shortcuts 

Toolbar:   
 

4.3 Download Information command (Action menu) 
 
Use this command to download data from logger or ChartReader. 
 
Shortcuts 

Toolbar:   
 
For more help see Display list of readings. 

 

4.4 Show Current Readings command (Action menu) 
 
Use this command to scan the currently connected logger.  
 
Shortcuts 

Toolbar:   

 
For more help see Scanning the Logger. 
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5. Window menu commands  
 
The Window menu offers the following commands, which enable you to arrange multiple views of 
multiple documents in the application window: 

 

5.1 New Window command (Window menu) 
 
Use this command to open a new window with the same contents as the active window.  You can 
open multiple document windows to display different parts or views of a document at the same 
time.  If you change the contents in one window, all other windows containing the same document 
reflect those changes.  When you open a new window, it becomes the active window and is 
displayed on top of all other open windows. 

 

5.2 Split command (Window menu) 
 
Use this command to split the active window into panes.  You may then use the mouse or the 
keyboard arrows to move the splitter bars.  When you are finished, press the mouse button or 
enter to leave the splitter bars in their new location.  Pressing escape keeps the splitter bars in 

their original location. 
 

5.3 Unsplit command (Window menu) 
 
Use this command to remove the split. 
 

5.4 Close command (Window menu) 
 
Use this command to close the active window. 
 

5.5 Close All command (Window menu) 
 

Use this command to close all opened windows. 
 

5.6 Cascade command (Window menu) 
 
Use this command to arrange multiple opened windows in an overlapped fashion.  
 

5.7 Tile Horizontally command (Window menu) 
 

Use this command to vertically arrange multiple opened windows in a non-overlapped fashion. 
 

5.8 Tile Vertically command (Window menu) 
 
Use this command to arrange multiple opened windows side by side. 
 

5.9 Window Arrange Icons Command 
 
Use this command to arrange the icons for minimized windows at the bottom of the main window.  
If there is an open document window at the bottom of the main window, then some or all of the 
icons may not be visible because they will be underneath this document window.  
 

5.10 1, 2, ... command (Window menu) 
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Escort Console displays a list of currently open document windows at the bottom of the Window 
menu.  A check mark appears in front of the document name of the active window.  Choose a 
document from this l ist to make its window active. 
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6. Help menu commands  
 
The Help menu offers the following commands, which provide you assistance with this application:  
 

6.1 Help Topics command (Help menu) 
 

Use this command to display the opening screen of Help.  From the opening screen, you can 
jump to step-by-step instructions for using Escort Console  and various types of reference 
information. 
 
Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen. 

 

6.2 Tip of the Day command (Help menu) 
 
Use this command to display Tip of the Day dialog. 
 

6.3 Check for new version command (Help menu) 
 
Use this command to connect to online information for updated versions of this application.  
 

6.4 Online command (Help menu) 
 
Use this command to connect to online service such as: 

 
• Visit Home Page.  

  Shortcuts 

  Toolbar:   
 
 

• Support Web Page. 
 

• Frequently Asked Questions Web Page. 
 

6.5 About Escort command (Help menu) 
 
Use this command to display the copyright notice, version number of your copy of Escort 
Console, and distributor contact information. 
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7. Toolbar  
 

 
 
The toolbar is displayed across the top of the application window, below the menu bar.  The 

toolbar provides quick mouse access to many tools used in Escort Console. 
 
Click  To 

 

 Open an existing file. Escort Console displays the Open dialog box, in which you 

can locate and open the desired file. 
 

 Save the active document with its current name. 

 

 Print the active document. 
 

 Log on user. 
 

 Log off user. 

 

 Insert the digital signature on an active document. 
 

 Prepare logger or ChartReader ready for use. 
 

 Program and configure loggers or ChartReaders. 

 

 Download logger trip information from loggers or from storage within ChartReaders. 
 

 Show the current sensor readings of the attached logger.  
 

 Copy the selection and put it on clipboard. 

 

 Zoom out the display to previous setting.  
 

 View the Internet home page for the product range supported by this software. 
 

 Display program information, version number and copyright. 

 

 Display help for clicked-on buttons, menus and windows. 
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8. Status Bar  
 

 
 
The status bar is displayed at the bottom of the Escort Console  window. 

 
 To hide or display the Status Bar, choose Options from the Edit menu and uncheck or check 
Display the Status Bar option from the General tab.  
 

 
 
 

The left area of the status bar displays the meaning of selected items as you navigate through the 
menus. This area also interprets the toolbar buttons.   
 

 This area also displays date/time and value data of any indicated point on the graph. 

 
The right areas of the status bar indicate which of the following keys are latched down: 
 
Indicator Description 
CAP The Caps Lock key is latched down. 

NUM  The Num Lock key is latched down. 

SCRL The Scroll Lock key is latched down. 
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9. View Manager - what is it and how to display it  
 
Escort Console supplies you with a helpful data viewing tool, the View Manager. 
The View Manager,  by default, occupies the left side of the Escort Console window.  

 

 
 
If you want to see the View Manager in any other Escort Console window location, simply select 

and drag.  
 
The View Manager has 3 tabs: 
 

Views To manage the type of reading, graph, or summary you would like 
to display. 

Links To manage which data you would like to analyze or compare. 
Analysis To manage which type of analysis you would like to add in the 

displayed readings or graphs. 
 

 
To hide or display the View Manager, choose Options from the Edit menu. Select or deselect 
Display the View Manager option from the General tab. 
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9.1 Views 
 
The Views window has 3 top-level headings. 
To expand or collapse the content of any headings just click on it. Each heading contains 2 items. 

To display the item double-click on the item you would like to see. 
 
Readings. 
 

List of readings displays a table with separate line for each reading taken. 
Each line shows the date and time the reading was made 
and the measurement made by each sensor. 

Readings and 

summary 

displays reading summary report followed by detailed list of  

actual readings. Summary report includes such facts as serial 
number and description of the logger, trip number, start and 
finish dates, time zone, number of readings, etc. 

 
2D Graph. 
 

Line  displays the logger’s reading as a line graph. 
Step displays the logger’s readings as a step graph.  

 
You can enlarge a section of the graph with the mouse. Move the mouse to one corner of the 

area you want to zoom, press the left mouse button, drag the mouse to the opposite corner, and 
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release the button to enlarge a section of the graph. Press the  toolbar button or  right click 

the mouse to restore (unzoom) the graph. 
 
Summary. 
 

Overview displays overview information of the current logger such as 
serial number, trip number, battery report, time zone, start 
and finish dates, number of readings, readings interval, 
logger’s range and specification. 

Statistic displays the serial number, the description, the highest and 
the lowest value of readings, the average value of readings 
and the Process Hygiene Index. 

 

9.2 Links 
 
The Links window provides a way to analyze and/or compare data from multiple loggers, which 
could have been logged over different time periods and/or different logging intervals. 

In the Links window you can see all the loggers and their sensors being that Escort Console 
has currently open and displayed. Simply select the loggers and their sensors to include their 
data into the current display window. If you want to include data logged by another logger into the 
current displayed graph, place a tick in the relevant sensor or logger tick box within the Links 
window. The Multiple Trip Synchronization Wizard will guide you through the process of 
including the data from the other logger into the current display. 

 
To compare log trip data gathered from multiple locations at similar periods of time, it is 
recommended that you select the option Compare trip data based on actual date/time of each 
reading’. 
For example, this will allow data recorded from one site to be compared with data from another 
during the same interval of time. 

 
To compare log trip data gathered from multiple and/or the same location during different periods 
of time, it is recommended that you select the option Compare trip data from different 

date/time period(s) . 
This is useful for comparing current log data with that of a previous week. 
 
To customize how the log trip data from loggers is included, select the option Manually define 
how the trip data is to be compared with other trip data . This will provide you with a screen 
that will allow you to manually adjust the alignment offset through the “Reading Offset” controls. 

 

9.3 Analysis 
 
The Analysis window has 2 top-level headings. 
To expand or collapse the content of any headings just click on it.  
The analysis functions allow you to see statistics or to calculate formulae for the measurements 

of the active logger data window. 
 

Calculated Values: 
 
Mean Average  select this option to display the average value of readings in 

the graph’s Legend. 
Highest reading select this option to display the maximum value of the 

readings in the graph’s Legend.  
Lowest reading select this option to display the minimum value of the readings 

in the graph’s Legend. 
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Dewpoint information select this option to display temperature at which air becomes 
saturated with water and begins to condense - forming dew.  

Process Hygiene 
Index(PHI) 

select this option to display the aerobic and anaerobic process 
hygiene index of readings in the graph’s Legend.  

Mean Kinetic 

Temperature(MKT) 

select this option to display the Mean Kinetic Temperature of 

the readings in the graph’s Legend. 
 
User Defined: 
 

Custom select this option to display custom defined value of readings in the graph’s 
Legend. 

 
Double clicking on the Custom item opens the Calculate Value Definition  dialog where you can 
set: 
 

Name any name you wish. For example ‘’Calculated fresh value of food’’. 
Formula enter the formula used to convert each sensor’s reading into the calculated value.  
 

Example:  
the value of fresh food is given as 
Fresh Value = (Measured Temperature - Target Temperature) * Time 
Assume the Target Temperature is 60°C. 

• Set the Formula to $ - 60. 
• Set the Time Units to hours. 

• Select Greater than or equal to option and set limit to 60. 
 
The mathematical operations currently supported include: 
 

Symbol What does it mean 

+ addition 

- subtraction 

* multiplication 

/ division 

^ raise to power 

( left bracket 

) right bracket 

sqrt() square root 

exp() exponential 

log() natural logarithm 

log10() base 10 logarithm 

abs() absolute value 

$ sensor value 
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10. Connecting a logger  
 
In order for the software to communicate with a logger you must connect the Communication 
Interface to a serial port on your computer. 

 

  
 

Place the logger into the Interface , making sure that the two metallic contacts on the bottom of 
the logger are aligned with the contact pins on the Interface  and that the logger is firmly seated. 
The software defaults to ‘’auto-detect’’ mode, which will check all the installed serial 
communications ports (COM) on your computer for a logger, ChartReader, or other known Escort 

products. 
 

 that the Interface is shipped with a standard 9-pin connector. If your computer is 
equipped with a 25-pin connector you will need to purchase a 25-pin female to 9-pin male 

converter. 
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11. How to program the Logger (overview)  
 
Programming a logger is the process of configuring a logger so that it will record the data you 
want, when you want it. 

To program a logger, click on the  toolbar button or select Program and Configure  from the 
Action menu. Escort Console will open Program and Configuration Wizard, which will guide 
you through the process. 
 

The ‘’Next >’’ and ‘’< Back’’ buttons will help you to navigate through dialogs. The ‘’Esc’’ key and 
‘’Cancel’’ button will exit you from the programming sequence without implementing any changes 
currently made. The ‘’|< Restart> button will return you to the first step of the dialog. 
When you program a logger, the first thing the software will do is retrieve the current program 
information from the logger. Once the programmi ng information has been retrieved, you may be 
prompted to enter a security code to enable re-programming of the logger 

 
You will be able to program: 
 

Sensor configuration 
 

The logger’s internal time clock 

 
The logger’s start and finish conditions  

 
 

11.1 Alarm settings options: 
 
Raise alarm on below lower spec reading Enable this option if you want the logger to raise 
an alarm if the temperature is less than the minimum specification that has been recorded.  
Raise alarm on above upper spec reading Enable this option if you want the logger to raise 
an alarm if the temperature is greater than the maximum specification that has been recorded. 

Deactivate alarm if conditions go back into spec This option means the logger will 
deactivate its alarm when the sensor goes back into its set specification. If this option is not 
selected and the logger alarm is activated, the logger will remain in warning mode until re-
programmed. 
Audible alarm and alarm link activation Enabling this option will make the logger 
continuously beep when an alarm event has occurred. 

Deactivate alarm by using the magnet  Enabling this option will allow you to reset 
logger’s alarm when a magnet passes over the logger label. 
Number of consecutive out of specification readings  Determines how many 
consecutive out of specification readings can occur before an alarm is raised. 
Total number of out of specification readings   Determines the total number out of 
specification readings can occur before an alarm is raised.  

 

11.2 Display (Liquid Crystal Display - LCD) settings options: 
 
Show the sensor’s reading on the display Enable this option if you want the logger’s 
display to show current sample.  
Indicate when the current reading is out of specification  Enable this option if you want 

the logger’s display to show a special symbol when the current sample above the maximum  
specification or below the minimum specification. 
Show the symbol of the sensor’s measurement units  Enable this option if you want to 
add a temperature symbol to the logger’s display. 
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Units of measurement of the readings on the display Allows the temperature scale the logger 
displays to be changed. 
 

 This dialog appears for loggers that have a display. 
 

11.3 Sensor configuration 
 
The available options include: 
 

Minimum any samples less than set value will be marked as out of specification. 
 
Maximum any samples greater than set value will be marked as out of specification. 
 
Increment the grouping size used for listing out of specification readings. 
 

For example, if a cargo’s temperature is allowed to vary 2 degrees from a nominal - 2 degrees 
then the minimum would be set to - 4 and the maximum would be 0. If increment was set to 2 
degrees, you would get a summary indicating the number of readings that fell outside the 

allowable parameters in 2 degree bands. That is, the number of readings between 0 and 2 
degrees, between 2 and 4 degrees, etc. Out of specification samples are marked with a ‘’*’’ 
symbol when displayed in a listed report. 
 

11.4 Modifying Date/Time 
 

This dialog allows you to adjust the logger’s time clock. The logger’s current date and time are 
displayed. There are three options available: 
 
Do not make any change to the date or time of the logger Select this option to leave the 
logger’s time clock unchanged.  
 

Change to the same date and time of this computer Use this option if you need to set 
multiple loggers to the same date and time. 
 
Set to Selecting this option allows you to manually input time. 
 

11.5 Start and Finish conditions 
 
This dialog allows you to control the start and finish points and the interval between each reading. 
 
Start new log trip  determines when the logger is to start logging. 

 You can select one of the following options: 
After a magnetic start the logger will start when a magnet passes over the logger label. 
In after selected days, hours and minutes. 
At selected date and time.  
 
Finish log trip determines when the logger is to stop logging. You can select one of the 

following options: 
After <number> readings  after selected number of  readings. 

After <time interval> after selected days, hours and minutes. 
At selected date and time.  
Continuous logging  logger will not stop, recording over its previous samples. 
 
To simplify the settings of the start and finish points: 
You can select Duration of your trip in days and start point only. Escort Console will set the 

finish point and the interval between each reading  automatically 
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11.6 Security options 
 
You can change the security code to safeguard your logger from unauthorized tampering. Make 
sure that you keep a note of your security code and logger serial number in a safe place. If you 

lose or forget the security code, the logger will have to be returned to the distributor or 
manufacturer to restore default password.  
 

For Junior loggers the security code can be up to 4 digits. Loggers are shipped from the 
manufacturer with a security code of ‘’1234’’. 
For Escort loggers the security code can be up to 20 characters long (letters and numbers) and is 
not case-sensitive. Loggers are shipped from the manufacturer with a security code of 
‘’ESCORT’’. 
 

Change Password click this button to open Password Setting dialog. 
 
Password Setting dialog has options: 
 

Protect program settings Enable this option if you want to protect your 
programming settings for the current logger. 

Protect retrieval of readings Enable this option to disallow viewing of data from the 
current logger without a password.  

 
Fields to enter and to confirm new password. 
 
 



 26 

 

12. How to download Data from the Logger  
 
1.Connect the logger to your computer. 
 How to connect the logger 

2.To download data from the logger, click on the  toolbar button or select Download 
Information from the Action menu. Escort Console will open Download Readings Wizard, 
which allows you to retrieve and view the recorded samples from the logger. 
3.After the data has been successfully downloaded you can change logger’s start conditions. You 

have 4 options: 
 

Do not upload any new 
start conditions to the 
logger 

Select this option if you want to keep current data in the 
logger’s memory. The new data will be added to the end 
of the existing list until the logger is reprogrammed or 
logging is finished. 

 
Wait [time] after a 
magnetic start 

Restart logger after a magnetic start. If [time] has not 
been selected, logger will activate immediately after the 
magnetic start. 

 
Start in Select this option if you want logger to start in a known 

time interval. For example, in 2 hours after 
programming. 

 
Start at Select this option if you want logger to start at known 

date and time. For example at 03/12/2002 10:41:55. 
 
4.To view the downloaded data click Finish button. 
 

 If you would like to download additional data from the Logger(s), you may do so by 
selecting Download information from additional loggers and/or ChartReaders option. 
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13. Scanning the Logger 
 

Selecting Show Current Readings from the Action menu, or clicking the  toolbar button, will 
produce a dialog box showing what the sensors of a logger are currently registering, updated in 
real time.  

 

 Scanning the logger quickly consumes battery power, so short scans are 
recommended. 
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14. Logger maintenance  

14.1 Cleaning Contacts  
 

It may prove necessary from time to time to clean the metal contacts on the logger and interface 
in order to ensure reliable communications.  The contacts may be cleaned gently with isopropyl 
alcohol or methylated spirits. 

 

14.2 Battery Replacement 
 

Junior loggers are designed to allow the user to replace the lithium battery when it has expired.  
An Escort logger’s battery is not user replaceable and these loggers must be returned to your 
distributor for battery replacement. 
 

 The Junior stores its data in a non-volatile mem ory so that even if the battery fails, the 
recorded readings are retained.  However, if battery power is lost for more than one minute, the 
Junior’s internal clock may stop and will need to be reset 
 

To replace the battery: 
1. Unscrew lid of Junior.  Sometimes the use of a lid unscrew tool may be required if the 

lid is seized on.  Contact your distributor if this is the case.  

 If you are replacing the battery of a humidity logger, care must be taken not to damage the 

humidity and temperature sensors that are exposed when the lid is removed.  As a precaution, 
the ’’black bung’’ these sensors are attached to can be unplugged from the logger and then re-
fitted when the battery has been replaced.  If you decide to do this, make sure the ’’bung’’ is 
inserted into the socket as shown in the diagram. 
 

     
 

2. Remove the expired battery. 
Check if battery contacts are dirty.  In the unlikely event they are, clean the contacts with 
isopropyl alcohol or methylated spirits and wipe dry. 

3. Insert new battery by placing battery negative (-) end against (-) spring and compress 
so that battery fits behind (+) spring.  Ensure battery is inserted with correct polarity.  If the 
Junior ‘’chirps’’ then the internal clock will need to be reset. 

4. Place logger in interface and access List using the software.  If logger beeps and is 
read correctly by the software, replace the lid. 
 
If the logger fails to beep or communicate after the battery has been replaced, remove the new 
battery, short the battery springs together with a piece of wire, like a paper clip, reinsert the new 
battery, and try again. 

 

14.3 Humidity Calibration 
 

In order to maintain the rated accuracy of the humidity sensor, a humidity logger should have its 
humidity calibration checked at least twice a year to detect and correct any ageing of the sensor 
element.  Note that the chemicals in some environments can cause accelerated ageing of the 



 29 

humidity sensor element and in these situations the calibration should be checked more 
frequently.  This checking and re-calibrating, when required, can be performed either by your 
distributor, or with the JCAL (for Junior loggers) or CAL (for Escort loggers) software and salt 
solutions available from your distributor. 
 

14.4 External Sensors 
 
When plugging external sensors into a logger, make sure that the connector is inserted correctly.  
Forcing an incorrectly aligned connector into its socket can damage the connector and/or socket. 
 

14.5 Junior Batteries 
 
Please note that ESCORT Junior loggers use a ½ AA size, 3.6 volt lithium battery, commonly 
used in cameras and available through respective retail stores.  Also, older model Junior loggers 
should use batteries with a large plus contact only, as contact problems can occur when short 
terminals are used. 

Small terminals: Large terminals: 

 

  
 

14.6 Replacing Escort Junior Logger Lids 
 
When replacing an Escort Junior’s lid, the following steps are needed to ensure a watertight and 
condensation-proof seal. 
 

1. Check that the o-ring and seat are clean and free of dirt and other contaminants. 

2. Grease the o-ring with an o-ring lubricant.  We recommend Dow Corning Molykote 111.  
3. Ensure that the o-ring is properly fitted into its seat in the lid. 
4. When screwing the lid on, do not over tighten as this may damage the thread. 

 
As Escort Data Logging Systems Ltd. can not control how you replace the lid, we are unable to 
guarantee the lid seal will remain watertight and condensation proof once the lid has been 

removed and replaced. 
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15. Connecting ChartReader  
 
In order for the software to communicate with a ChartReader you must connect the 
Communication Interface  to a serial port on your computer. 

 

  
 

Connect the ChartReader to the Interface. The software defaults to ‘’auto-detect’’ mode, which 
will check all the installed serial communications ports (COM) on your computer.  

 

 the Interface is shipped with a standard  9-pin connector. If your computer is 

equipped with a 25-pin connector you will need to purchase a 25-pin female to 9-pin male 
converter. 
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16. How to program the ChartReader  
 
Programming ChartReader configures the chart and list printouts.  
 

1.Connect the ChartReader to your computer. 
 How to connect the ChartReader  
 

2.Click on the  toolbar button or select Program and Configure from the Action menu. 

Escort Console will open Program and Configuration Wizard, which will guide you through the 
process. 
 
The ‘’Next >’’ and ‘’< Back’’ buttons will help you to navigate through dialogs. The ‘’Esc’’ key and 
‘’Cancel’’ button will exit you from the programming sequence without implementing any changes 
currently made. The ‘’|< Restart’’ button will return you to the first step of dialog. 

If password access for the ChartReader has been enabled, you may be prompted to enter the 
password into the security access dialog. 
 
You will be able to program: 
 

Details tab. 
 
This dialog allows you to change general information stored in the ChartReader.  A description, 
such as the site name where ChartReader is located, an asset or inventory number, may be 
entered into the appropriate fields. You can also enter up to 4 lines of text into the text fields of 
the Printable Messages boxes. These 4 lines will appear at the beginning of every ChartReader 
printout. 

 

General tab. 
 
This dialog allows setting of other operating, power and miscellaneous options for the 
ChartReader. 
 

Temperature Units 
The temperature units used on printed graphs can be set by selecting from the drop -
down Temperature units menu.  For example, °C can be chosen as the unit of 
temperature by selecting Celsius from the menu. 

Date Format 
Similarly, the format of the date on printouts can be chosen by selecting from the drop-
down Date Format menu.  As an example of the selected date format, the current date is 
displayed at the centre-bottom of the Printout Options box. 

Enable internal beeper  

This option will enable the beeper in the ChartReader, which indicates such things as the 
ChartReader's communication with a logger, the successful re-arming of a logger and 
that the ChartReader has run out of paper. 

Can re-arm a logger  
If this option is enabled, the ChartReader will have the ability to re-arm loggers after 
downloading their data.  The ChartReader will be able to rearm a logger, with the same 

logging parameters, for a magnetic start.  Note that if a logger was originally programmed 
for a timer start, rearming for a magnetic start will prevent the timer start.  

Can store multiple downloads  
If this option is enabled, the ChartReader will be able to store data from more than one 
logger and/or multiple trips from the same logger(s).  Each download from a logger is 
stored as a "Data Block". 
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Turn-off after 
You can set the amount of time the ChartReader will wait, when idle, before automatically 
turning off. 

 

Options tab. 
 
This dialog allows the setting of list and graph options for the ChartReader.  
 

Only out of specifications readings   
When this option is enabled, each list printout will include only out-of-specification 
readings. 

Include the log cycle summary   
When this option is enabled, each list printout will include a summary breakdown of the 
out-of-specification readings after the actual listed readings.  In this summary, the total 

amount of time out-of-specification is broken down into four bands, based around the 
summary increment.  Two of these bands group data points above upper specification, 
while the other two bands group data points below lower specification.  For more 
information on the list printout and the log cycle summary, refer to your ChartReader 
manual. 

0°C (32°F) reference line 

When this option is enabled, a 0-degrees Celsius reference line is included on each 
graph printout. 

Specification lines 
When this option is enabled, the ChartReader will print lines representing the maximum 
and minimum specification values, as originally defined during the logger's programming 
sequence 

Sensor labels on each section 
When this option is enabled, each section of the printed graph will be annotated with 
sensor labels identifying which sensor the data points are associated with.  For example, 
"I" represents an internal sensor, "E" represents an external sensor and "H" represents a 
humidity sensor.  These labels will be printed at the bottom of each section.  These 
marks will not, however, appear for loggers with a single sensor. 

Y-Axis on each section 
When this option is enabled, each section of the logger’s graph printout will be 
individually annotated with a labeled Y-Axis. 

Log cycle summary 
When this option is enabled, graph printouts will also include a summary breakdown of 
the out -of-specification readings.  This is the same log cycle summary as that included at 
the end of ChartReader list printouts. 

 

Graphs tab. 
 

There are two options available for defining the Y-Axis range of printed charts.  The first 
option is to use the sensor's working range as the range of the graph.  Select Full range 
of the sensor to choose this option.  For example, if the sensor's range is -39.5°C to 
39.5°C and this option is selected, the Y-Axis range will be based on these limits. 
Alternatively, chart Y-Axis ranges can be calculated from the specification and increment 

values, as originally defined in a logger's programming sequence, by selecting the  
Specification range and multiples of the increment option.  For this option, the 
number of specification increments to include in the chart range can be set with Number 
of specification increments to use .  The maximum number of increments to be used 
must be less than 256. For example, if the specification limits are +15°C (minimum) and 
+25°C (maximum), the summary increment is 2°C, and the number of specification 

increments to use is set at 3, the Y-Axis limits would be   
 15°C - (3 * 2°C) = +9°C (lower) 
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and 25°C + (3 * 2°C) = +31°C (upper). 
The value in the Round Y-Axis to the nearest field, controls the amount that the Y-Axis 
range labels can be rounded by; Y-Axis range values are rounded to the nearest multiple 
of this value.  This rounding applies to the range values as set above.  In the above 
example, if the rounding applies to range values set to 2, the Y-Axis range would be 8°C 
to +32°C.  The default value is 5. 

 
Text orientation 

You can choose Portrait to print text horizontally across the page.  This is the default 
mode used in previous versions of ChartReader.  You can also choose Landscape , 
which prints the graph header and axis and sensor labels vertically up the page.  When 
this option is enabled, you can also use the Compression feature if you wish.  

Compression 
Graph printout compression allows ChartReader graph printouts to be printed using a 

shorter than normal section of paper.  This feature can save time, paper and the printer 
ribbon.  Compression is only available if Landscape text orientation is selected. 
You can select from the drop-down list: 
None 

Choose this option to print graphs out full size, with a printed dot representing each 
sample.  

Thumbnail (40mm maximum length) 
Choose this option to print graphs with a maximum length of 40 millimeters.  The 
ChartReader will then calculate an appropriate compression ratio for each graph 
printout.  Note that this is a maximum length; if a log cycle has too few logs to fill 
40mm, it will be printed normal size.  Note also that because a ratio is used to 
compress the graph, it may print smaller than 40mm. 

Half length 
Choose this option to print all graphs half size, using one printed dot for every two 
readings.  This is represented by a ratio of 2:1. 

Custom maximum length 
You can specify a maximum length for all graphs, in millimeters, with this option.  
Type the length you require into the ‘mm’ box beside the drop-down list.   
As with the Thumbnail option, the ChartReader will calculate an appropriate 
compression ratio for each graph printout.  Note that this is a maximum length; if a 
log cycle has too few logs to fill the specified length, it will be printed normal size. 

Note also that because a ratio is used to compress the graph, it may print smaller 
than the specified length. 

Custom ratio 
You can specify your own compression ratio by selecting this option.  Type the ratio 
into the box beside the drop-down list.  Because this ratio represents the number of 
readings to be displayed on a single line, you can only enter a whole number. 

 
3.Click Finish button after the ChartReader has been programmed successfully. 
 

 If you would like to program additional ChartReaders, you may do so by selecting Program 
and configure additional loggers and/or ChartReaders option. 
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17 Security options  
 
You can change the security code to safeguard your ChartReader from unauthorized tampering. 
Make sure that you keep a note of your security code in safe place. If you lose or forget the 

security code, the ChartReader will have to be returned to the distributor or manufacturer to 
retrieve your password. 
 
When you are programming the ChartReader click  Change Password button in the Details tab 
to open Password Setting dialog. 
 

The Restrict Access option allows control of password access. This password will protect 
access to the configuration of the ChartReader, as well as data stored in the ChartReader.  It will 
not protect the operation of the ChartReader, as the keypad will still be active. 

 
If password access is enabled, you can set the password by typing it into the Password field, and 
again into the Confirmation field.  The password may contain alphanumeric characters and is 
case sensitive.  
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18. How to download Data from the ChartReader  
 
1.Connect the ChartReader to your computer. 

 How to connect the ChartReader 

2.To download data from the ChartReader, click on the  toolbar button or select Download 

Information from the Action menu. Escort Console will open Download Readings Wizard, 
which allows you to retrieve and view the recorded samples from ChartReader. 

3.After the data has been successfully downloaded you can free up memory capacity of 
ChartReader. Select Delete all data blocks from within the ChartReader(s), if this option is 
enabled, all the logger data currently stored in ChartReader will be deleted when the 
configuration settings are uploaded.  This will free up memory capacity to store data from further 
loggers. 
4.To view the downloaded data click Finish button. 

 If you would like to download additional data from the ChartReader(s), you may do so by 
selecting Download information from additional loggers and/or ChartReaders option. 
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19. ChartReader maintenance  
 
 

19.1 Powering & charging the ChartReader 
 
The ChartReader contains an internal NiCad battery which typically, when fully charged, can 

provide power for about 1 hour of continuous printing.  
 
To charge the NiCad battery, plug a 12V @ 1A supply into the DC connector located at the rear 
of the case. The plug needs to be a 2.1mm DC plug with negative on the inner connection. 
(An adaptor of lesser current rating (i.e. say 0.7 amp) can be used but this will increase the time it 
takes to fully charge the battery.) A 12V car cigarette lighter adaptor can also be used.  

 
When connected to a suitable power supply, the ChartReader will indicate that the battery is 
being charged by flashing the  ON  light.  
 
The battery will normally take up to 2 hours to fully charge with 90% of the charge being attained 
within the first hour. The charger can be left permanently plugged in without damage to the 
ChartReader or battery. 
 
Sometimes the battery will not take on a fast charge and the ON light will stop flashing well before 

1 hour is elapsed.  In this case the ChartReader will continue to charge the battery in a ’’trickle 
charge mode’’ and may take up to 18 hours to fully charge a battery. 
 
It is highly advised that the battery is fully exhausted before recharge to maximise life and 
capacity of the battery. 
 

Note that because the ChartReader uses an intelligent charge technique, it cannot be turned off 
when external power is applied (i.e. a charger is connected). As soon as the external power 
supply is plugged into an inactive ChartReader, it will automatically turn on to maintain the 
charging of the battery. 
 

19.2 Power failure 
 
The battery will typically exhaust itself during printing as this is the most energy consuming 
activity. When the battery is becoming exhausted, the ON indicator will rapidly flash and a beep 
will be sounded. If this occurs during printing (the most likely time) the printing will pause until 
either the battery voltage rises or a charger is plugged in. 
To continue using the ChartReader, plug in an external power source. As long as the printing was 

not aborted it will automatically continue once a suitable ex ternal power supply is attached.  
 

19.3 Overview of power indicator modes 
 

Action Meaning 
ON Indicator slowly flashing with 

charger plugged in.  

Charge in progress.  

ON Indicator permanently on with 
charger plugged in.  

Fast Charge completed. Battery trickle charged.  

ON Indicator flashing rapidly with 
beeping.  

Battery nearly exhausted.  

ON Indicator not on ChartReader inactive (turned off).  

  

 The NiCad battery is not included in the warranty.  
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19.4 Changing printer paper & ribbon 
 
A. PRINTER PAPER ROLL REPLACEMENT 
 

The ChartReader uses standard 57mm wide paper or 2 layer 57mm wide NCR type duplicating 
paper. 
To replace the paper roll perform the following steps: 
 

 NEVER PULL PAPER BACKWARDS THROUGH PRINTER MECHANISM AS 
IRREPARABLE DAMAGE WILL RESULT! 

 
1. Open the hinged lid by springing the plastic clip at the rear of the case and lift the lid     
      open.  
2. Remove the short length of paper remaining in the printing mechanism by: 

• using the small FEED button located on the circuit board to the left of the printer 
mechanism, or 

• using the manual wheel (if present), or 

• gently pulling the paper through the mec hanism by hand in normal direction. 
 

 
 

3.  Remove old roll core from the holding fingers and insert the new roll with the paper direction 
as shown in the diagram above.  
4. Free the end of the new paper and ensure that the end is cut reasonably straight and square. 
Trim with scissors if necessary. 
5. Take the free end of the paper and gently push it over the plastic ramp and into the mouth of 
the printer. 

6. By using the manual feed knob (if present) or the FEED button (with power ON), feed the 
paper through the mechanism, past the ink ribbon and leave about 6mm (¼ inch) of paper 
protruding from the top of the mechanism. 
7. Tighten the ink ribbon in it's cassette by turning the star shaped disc (on the left of the cassette)  
2 or 3 turns clockwise. 
8. Close the case lid making sure the paper feeds through the gap in the lid and secure the lid 

catch. 
 
B. RIBBON CASSETTE REPLACEMENT 

 
Printing on plain paper in the ChartReader is achieved by use of an inked ribbon which is 
contained in a replaceable cassette mounted on the printer mechanism. 
 
The ribbon will normally last for 2 to 3 rolls of paper. 
 

To replace the ribbon cassette, perform the following steps: 
 
1. Open the lid of the ChartReader. 
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2. Press down on the right end of the ribbon cassette to pop the left end up. The cassette can 
now be lifted out. 
3. Pass the paper through the new ribbon cassette and load the cassette in the mechanism by 
positioning the left end of the cassette in the mechanism and gently pushing the right end into 
place. 
4. Using the star-shaped disc on the left of the ribbon cassette, tighten the ink ribbon by turning 
the wheel clockwise, so it is straight and lying neatly behind the paper in the mechanism. 
5. Close the case lid making sure the paper feeds through the gap in the lid and secure the lid 

catch. 
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20. Display list of readings  
 

To extract data from a logger, click on the  toolbar button or select Download Information  

from the Action menu. Escort Console will open Download Readings Wizard, which allows you 
to retrieve and view the recorded samples from a logger. 
 
If you are using an Escort logger and the beeper is turned on, or you are using an Escort Junior 
logger, you will hear several “beeps” while data is being downloaded.  These beeps indicate that 

the logger is sending information to your computer.  Note that if the Protect Data option is 
enabled, you will have to provide the logger’s security code before being able to retrieve the 
readings. 
 

List of Readings 
When the data is initially extracted from a logger it may be displayed in the following form: 

• List of readings 

• Readings and summary  
• 2D graph - Line 

• 2D graph - Step 

• Overview 

• Statistic 
 
Program Summary 

• This includes such facts as: 

• Description of the log trip. 
• Which sensors were used. 

• Number of readings taken. 

• Trip number. This number is incremented every time a logger is programmed and starts a 
new log. 
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21. Supported file formats  
 
When you are saving the file for the first time or after selecting Save As menu, Escort Console 
opens ‘’File Save’’ dialog. This dialog allows you to specify what file format to save the data into, 

what name to call the file and in what location to save the file. 
 

 Default file name [Serial number] - [Trip number]  
 

[Serial number] is the serial number of the logger. 
[Trip number] is the current trip number of the logger. 

 
The supported file formats are: 
 

21.1 Logger Compact Files 
 
If you want to save data for later study using this software you must save it using this format. 
Logger Compact File can only be read by Escort Console. 
 

21.2 CSV (Comma delimited) 
 

This is a commonly used format to permit data to be imported into a spreadsheet or database:  
writing the readings to a text file using a comma ‘’,’’ to separate each field on a row. Each row, in 
addition to the reading data, includes the reading number, the date and time of the reading and 
the elapsed time since the log cycle began. The summary information is displayed at the top of 
the list. The out of specification summary is displayed after the list of readings. 
 

 data cannot be read back into this software using  this format. 
 

21.3 Formatted Text (Space delimited) 
 

This writes the readings to a text file.  Each field in a row of data is placed at a common offset, 
separated by spaces.  This is a commonly used format to permit the data to be imported into 
spreadsheet, database or word-processor software 
 

 data cannot be read back into this software using  this format. 
 

21.4 SYLK (Symbolic Link) 
 
This stores the readings as a SYLK file that most spreadsheet programs are capable of loading. 
Each row (representing a reading) in the file includes the reading number, the date and time of 

the reading and the elapsed time since the log cycle began. The summary information displayed 
at the top of the list view and the out of specification summary displayed after the list of readings, 
are also included in the file. 
 

 data cannot be read back into this software using  this format. 
 

21.5 Text (Tab delimited) 
 
This is a commonly used format to permit the data to be imported in to a spreadsheet, database 
or word-processor software application. The summary information displayed at the top of the list 
view and the out of specification summary displayed after the list of readings, are also included in 
the file. This writes the readings to a text file with a Tab to separate each field on a row.  Each 
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row (representing a reading) in the file includes the reading number, the date and time of the 
reading and the elapsed time since the log cycle began 

 

 data cannot be read back into this software using  this format. 
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22. Print list of readings  
 

To print data from a logger, click on the  toolbar button or select Print from the File menu. 

Escort Console will open Print dialog where you may specify the range of pages to be printed, 
the number of copies, the destination printer and other printer setup options  
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23. What is FDA 21 CFR Part 11. 
 
The Food and Drug Administration (FDA) issued regulations that provide criteria for acceptance 
by FDA, under certain circumstances, of electronic records, electronic signatures, and 

handwritten signatures executed to electronic records as equivalent to paper records and 
handwritten signatures executed on paper. These regulations, which apply to all FDA program 
areas, are intended to permit the widest possible use of electronic technology, compatible with 
FDA’s responsibility to promote and protect public health. Part 11 applies to any record governed 
by an existing FDA predicate rule that is created, modified, maintained, archived, retrieved, or 
transmitted using computers and /or saved on durable storage media.  

 

For more information, please visit this website:  

Title 21 Code of Federal Regulations (21 CFR Part 11) Electronic Records; Electronic Signatures 
(http://www.fda.gov/ora/compliance_ref/part11/Default.htm) 
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24. How to achieve FDA 21 CFR Part 11 compliance. 
 
You need to install ’’User Admin Package for Title 21 CFR Part 11 compliance’’, which allows 
creation of a database of electronic signatures and their individual responsibilities/abilities. 

 
’’User Admin Package for Title 21 CFR Part 11 compliance’’  is a software product which 
provides complete FDA 21 CFR Part 11compliant user login functions, and a comprehensive 
administrator console. 
 
Business benefits of Part 11 compliance: 

• recognizes electronic records as legally equivalent to paper records, thereby eliminating 
the need for the maintaining paper based records; 

• ensures that critical information remains secure and private; 

• automation of administrative and manual entry, tracking, audit, and validation processes; 

• improved ability for the firm to analyze trends, problems, etc., enhancing internal 
• evaluation and quality control; 

• reduced costs of storage space 
• reduced shipping costs for data transmission to FDA 

• more efficient FDA reviews and approvals of FDA-regulated products; 
• increased speed of information exchange; 

• enabling of more advanced searches of information, thus obviating the need for manual 
paper searches. 

 
To get this package, please contact your local distributor. 
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25. How to get further assistance   
 
To get further assistance, please contact your local distributor. 
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26. Frequently Asked Questions (FAQ) 
 

26.1 General Questions 
 

• What causes the alarm on the logger to activate? 
The alarm will activate when the temperature that the logger records is not within the 

specified monitoring range, as defined in the sensor specification step of the programming 
process. 

 
• Why does the alarm, Red, LED on the logger still blink even when the logger has 

finished? 
This feature is provided so that you are aware that the logger was in alarm mode when 

the logger finished its logging.  When monitoring temperature sensitive cargo, for example, this 
feature is extremely useful to give an immediate indication that the cargo may not be in an 

acceptable condition. You may stop the alarm, Red, LED flashing by swiping a magnet over the 
logger in a similar fashion to starting the logger.  
 

• Why does the LCD display incorrect sensor readings?   
When the logger is programmed to display different sensor readings using an alternate 

scale, for example °C instead of °F, then the logger must be instructed on how to display these 
new values.  This will extend the time involved in transferring program settings to the logger.  If 
this process is not successfully completed, for example because the logger was removed from 
the interface while transferring the new program settings to the logger, then the LCD will appear 
to display incorrect sensor readings. 

 
• There is some funny grease on my humidity logger, why is that? 

The only grease deposit on a humidity bung should be around the perimeter of the o-ring, 
which is located in the recess of the upper black bung. This will assist un-screwing the lid for 

battery replacement in the same way that it assists on the lid o-ring. Any other grease deposit is 
purely accidental. Please be careful when you handle the bun g during battery replacement, as 
there MUST not be any grease deposit on the actual humidity sensor, as it will affect its accuracy 

and calibration. The grease we use is DowCorning Molykote 111, which is valve and o-ring 
lubricant. This is also used on the battery terminals to prevent corrosion.  

 

• My humidity logger does not show any sensible humidity or temperature readings, 
only <-22.2 & 100%, but I can program and list OK, what is wrong? 
The most likely cause is that you have at some stage removed the bung with the sensors 

for battery replacement, and subsequently put it back the wrong way around. Check, that the 
sensor is located as in this drawing:  

 
 

• My logger has LED’s, but the activity LED does not blink, even if the logger is 
logging, why? 
You have turned the beeper off. The LED and the beeper work off the same internal 

signal. If you turn the beeper back on, the activity LED will also start blinking again. This is done 

during the programming of the logger in the Program and Configuration Wizard (see 
Programming the Logger) where you can also change the password settings. 
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• Why are there two different specifications for resolution and accuracy? 
Resolution and accuracy are two different things: 
Resolution is the smallest interval measurable by a scientific instrument. In the case of 

Escort loggers, these are the steps indicated by the temperature table. If two consecutive 
values in the table read 5ºC and 5.5ºC the resolution is 0.5ºC, as the logger can not hold 
any values (and the software can not display any values) in-between these two. Even if the 
real temperature is 5.2ºC, either 5.0ºC or 5.5ºC will be displayed. The resolution of 
thermistor based sensors is NOT constant across the temperature range, as thermistors 
are a non-linear device. 
Accuracy is the degree of refi nement in measurement. In case of a logger this is what the 
electronics are theoretically capable of achieving, if the resolution was infinitely small. If the 
true temperature value was 5.053ºC and the electronics have an accuracy of 0.3ºC, any 

value between 4.753ºC and 5.353ºC is considered within the accuracy of the logger. This 
does NOT necessarily mean that the value can also be displayed, as this is again based on 
the resolution of the instrument. If the electronics determine that the true temperature value 
is 5.29ºC, in above example either 5.0ºC or 5.5ºC will be indicated. The accuracy of the 
loggers is constant across the temperature range.  
Absolute accuracy (AA) is based on both accuracy (A) and resolution (R) and is 

(scientifically) calculated from the square root of the sum of the squared resolution and 
accuracy. AA=SQR(RES^2 + A^2). This is difficult to ascertain, as the resolution of the 
logger varies with temperature. In above example AA=SQR(0.5^2+0.3^2) = 
SQR(0.25+0.09) = 0.58ºC. The true temperature value can therefore be as much as 0.58ºC 
out from the actual temperature displayed for the logger still to be considered within 
specification. As the resolution is coarser at both ends of the range, this value becomes 

greater the closer you measure to the end. This is why we recommend, that if a logger is 
predominantly used in a specific application the average temperature of that application 
should be in the middle of the logger's range, where resolution and with it the capability of 
displaying an accurate value will be best. 

 

26.2 Computer and Logger Communication 
 

• The software says it can’t communicate with the logger, or that the logger is 

responding incorrectly; what might be the cause? 
1. Check to ensure that the logger is placed firmly on the interface.  

2. The interface is not, firmly, connected to the computer.  Check the connection. 
3. There is a foreign substance on the interface and/or logger contacts preventing reliable 
contact. 
4. The software is not configured to the serial port in use.  Please ensure that the 
selected communication port in the Communications dialog is the same as that being 
used. To open the Communications dialog please select Options command (Edit menu) 

5. The battery within the logger is flat and requires replacing. 
6. Another serial device, for example an internal fax/modem, is sharing the same address 
space and/or interrupts request (IRQ) line. In such case you should try to use another 

serial port, or to remove conflicting device so you may use this COM port. 
7. You may require a Serial Port Adapter (see below for further information). 
8. You are experiencing communication errors.  Please check with your computer vendor 
to ensure your communication ports are configured and functioning correctly. 
9. The logger has corrupted configuration data, possibly as a result of the electronics 
being subjected to an excessive electrostatic discharge or exposure to high EM fields.  

Logger will require servicing.  
 

• I have upgraded to a new computer, but my logger does not communicate any 
longer, why? 
Please make sure that all your communication settings are correct, and also check that 

no other serial devices (for example mouse, modem etc) try to access the serial port at the same 



 48 

time as the ESCORT software.  You may also require a Serial Port Adapter (see below). Also 
check that your logger is still working on a different PC.  More suggestions for troubleshooting 
can be found in the "Diagnostics Form". 

 

• What is a Serial Port Adapter, and why do I need it? 
Some of the latest PC’s may incorporate communications hardware (COM ports), which 

implement the RS232 specifications differently to the previous generations of computers (usually 
to reduce costs, heat and EM fields). The ESCORT Junior requires certain signal levels to 
communicate. We have therefore developed the Serial Port Adapter, which corrects some of the 
signal levels to allow successful communication even to PC’s with such COM ports. You may 
experience "no reply" messages, or faulty data are reported to the software like completely wrong 
serial numbers, wrong temperature ranges or a wrong logger type. If the same 

software/logger/interface combination operates successfully on another PC, you most likely 
require a Serial Port Adapter. 

 Smart Interfaces (JA-INT manufactured after 2001, the first two digits of the serial 

number show the year of manufacture) doesn’t require a Serial Port Adapter as all current 
versions are communicating flawlessly with all current serial ports. 

• Why can the software communicate with my old loggers but no t my new one(s)? 
The Escort product range is continually being improved upon and new variations are 

continually being created.  It is very likely that the version of software that you are using is not 
aware of the new features included in your new logger(s) and therefore is unable to safely access 

the logger.  To overcome this problem you will need to contact your local distributor to obtain the 
latest version of the software that will communicate with the new logger(s).  
 

26.3 Programming loggers 
 

• I am using the logger in a light sensitive environment, how do I make sure the 

LED's always remain off? 
It is possible to ensure the alarm, Red, LED is never activated during a logging period by 

ensuring the ‘’Raise alarm on above upper spec readings’’ and the ‘’Raise alarm on below lower 
spec readings’’ options are disabled.  On some models of loggers, the active, Green, LED can be 

disabled by disabling the ‘’Beeper On’’ option in the ‘’Miscellaneous Settings’’ window of the 
programming sequence. 
 

• My password has changed, but I did not type a new one in; what is wrong? 
The password prevents an unauthorized person from overwriting your data. There is no 

"back door" into the logger if you forget your password, so please make sure no other person has 
access to your password and changes it without your knowledge.  If you are sure you have not 
reprogrammed your password, you may have inadvertently changed it by entering the Password 
Setting dialog (see Security Options), and hitting the "OK" button, rather than the "Cancel" button. 
In this case the password has changed to a blank password, and pressing ‘’OK’’ in the Security 
Access dialog will get you to the next dialog box, without having to enter a password.  You can 
then set the password in the normal way. 

 

Other possible reasons include:   
1. The password within the logger has been corrupted.  The software will attempt to reset 
the password back to the factory default. 
2. You are experiencing communication errors.  Please check with your computer 
vendor to ensure your communication ports are configured and functioning correctly. 
3. The logger has corrupted configuration data, possibly as a result of the electronics 

being subjected to an excessive electrostatic discharge or exposure to high EM fields.  
The logger will require servicing. 

 

• Why doesn’t the software recognize the logger?  
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1.The current version of software being used was created prior to the version of the 
logger being used.  You will require the latest version of the software to use this logger. 
2.You are experiencing communication errors.  Please check with your computer vendor 
to ensure your communication ports are configured and functioning correctly. 

• The software has reported that the logger has been reprogrammed; why is this 

important? 
1. The software has detected that the logger has been re-programmed after the last set 
of readings was logged.  Some of the data within the stored readings may not be correct, 
like the date and time each reading was taken. 
2. You are experiencing communication errors.  Please check with your computer vendor 
to ensure your communication ports are configured and functioning correctly. 
3. The logger has corrupted configuration data, possibly as a result of the electronics 

being subjected to an excessive electrostatic discharge or exposure to high EM fields.  
The logger will require servicing. 

 

26.4 Using loggers 
 

• When should I use an external sensor instead of the internal temperature sensor? 
1. When the best response time is required.  An external sensor will respond to changes 
in temperature slightly quicker than an internal sensor.  Refer to your logger’s published 
specifications for further details.  
2. When the temperature of the environment may not be within the operating temperature 

limits of the logger. 
3. When the logger cannot be placed within the cargo to be monitored and the 
temperature within the cargo is what is to be monitored.  An external temperature sensor 
occupies far less space than a logger will. 
4. When the environment to be monitor ed is in a non-transparent and/or soundproof area 
and it is required to continuously view the status of the logger, like if the logger is in alarm 

mode.  A logger does not need to be located in the same area as the external 
temperature sensor. 

 

• Where is the best place to place the logger and/or the external sensor? 
A logger, or external temperature sensor, best functions when placed in a location where 

abnormal air currents are not an issue.  For example, if you want to monitor the temperature of a 
room, it is advisable not to place the logger too close to the door.  Otherwise, every time the door 
is opened the logger will be subjected to the temperature of the neighboring room, while the 

average temperature of the room may not actually significantly change. 
 

• Why are all the readings from the external sensor that the logger took, below the 
temperature range of the logger? 

The logger was unable to communicate with the external sensor.  The most likely reasons 
include: 

1. The sensor was not plugged firmly into the logger, check the connection. 
2. There is foreign substance on the external sensor socket or the external sensor plug, 
preventing reliable contact. Please check and clean the plug and sensor. 
3. The external sensor assembly is at fault.  The external sensor will require servicing, if 

available for this model of sensor, or replacing.  Please contact your distributor for the 
options. 

• I replaced the battery in the logger, but now the dates and times in my listed report 
are wrong.  Is there any way to fix this? 
1. Program the logger without changing any settings, except make sure that: 

a. The logger’s internal date and time are after the logger did, or would have, 
finished the last logging cycle. 

 b. The start logging time is exactly when the first reading was taken.  
 c. The number of readings to take is the same as the number of readings taken. 
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Do not start the logger logging otherwise the stored readings will be lost. 
2. Create a listed report from the stored readings as per normal and the dates and times 
of each stored reading should be correct.  You may ignore the warning message that the 
software will report concerning that the logger has been re-programmed 

 



 51 

 

27. Software registration  
 
At start up of this software you will see the Registration dialog, which gives you two options , 
register or quit. This dialog can be turned off by choosing Do not remind me of this again. You 

can always register later by choosing License command from Help menu. 
 
To register your installation and thereby gain access to the professional features of this software, 
click Register button. This will open for you License Registration dialog. 
 
License Registration dialog displays: 

Program name  - name of this software;  
Current license  - current status of your license; 
Restriction - restriction of your license;  

Brief instruction; 
Site Code  – sequence of characters and numbers identifying this installation of the 
software. This code has to be submitted to obtain a site key; 
Site Key - key, which should be entered to register software. 

 
To obtain a license please send your Site Code  to your local distributor and pay the 

corresponding license fee.  
To e-mail Site Code: 

1.Click Copy button. 
2.Create new e-mail message and paste Site Code  into your message. 
3.Send completed message.  
 

When you will receive Site Key: 
1.Copy Site Key from e-mail message.  
2.In License Registration dialog click Paste button or type manually Site Key into 
required field. 
3.Click OK button.  

 

Software will open for you Registration dialog with confirmation. Click OK button. 
 
You can always check status of your license by choosing License  command from Help menu. 
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28. Warranty  
 
The Escort loggers and ChartReaders have a 36 months warranty valid from date of purchase. In 
the event of a malfunction please contact your distributor. The warranty has the following 

exclusions: 
1. If the unit has been modified from manufacturer’s specifications. 
2. Exposure of the logger to temperatures less than -45°C or greater than 85°C, unless 
the logger is designed for use in temperatures outside this range (for example the 
Autoclave logger). 
3. Loss or damage caused by the ingress of moisture. 

4. Evidence that the printed circuit board has been removed or tampered with.  
5. Evidence of mistreatment or abuse. 
6. Loss of unit. 

Batteries are not covered by this warranty. 
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